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COPYRIGHT NOTICE:
Both this book and the software described by this book are 
protected by copyright. You may not copy or reproduce this book 
in any form without prior written permission from Liquor 
Monitor, LLC. The software associated with this product is 
governed by a license agreement. This software is yours to use as 
long as you adhere to the terms of the license agreement.

Printed in the United States.

© 2006-2009 Liquor Monitor, LLC. All rights reserved.

TRADEMARK NOTICE:
Liquor Monitor is a trademark of Liquor Monitor, LLC. Other 
products are trademarks of their respective manufacturers.

LICENSE AND WARRANTY:
NOTICE:  LIQUOR MONITOR, LLC. LICENSES THE 
ENCLOSED SOFTWARE TO YOU ONLY UPON THE 
CONDITION THAT YOU ACCEPT ALL OF THE TERMS 
CONTAINED IN THIS LICENSE AGREEMENT. PLEASE 
READ THE TERMS CAREFULY AS OPENING THE 
PACKAGE INDICATES YOUR ASSENT TO THEM. IF 
YOU DO NOT AGREE TO THESE TERMS, THEN 
LIQUOR MONITOR, LLC. IS UNWILLING TO LICENSE 
THE SOFTWARE TO YOU, IN WHICH EVENT YOU 
SHOULD RETURN THE FULL PRODUCT WITH PROOF 
OF PURCHASE TO THE DEALER FROM WHOM IT WAS 
ACQUIRED (IN COMPLIANCE WITH THE DEALER’S 
RETURN POLICY).

The software which accompanies this license (the “Software”) is 
the property of Liquor Monitor, LLC. or its licensors and is 
protected by copyright law. While Liquor Monitor, LLC. 
continues to own the Software, you will have certain rights to use 
the Software after your acceptance of this license. Except as may 
be modified by a license addendum which accompanies this 
license, your rights and obligations with respect to the use of this 
Software are as follows:

• You may:

(i) use one copy of the Software on a single computer;

(ii) make one copy of the Software for archival purposes, or 
copy the software onto the hard disk of your computer and 
retain the original for archival purposes;

(iii) use the Software on a network, provided that you have a 
licensed copy of the Software for each computer that can access 
the Software over that network; and

(iv) after written notice to Liquor Monitor, LLC., transfer the 
Software on a permanent basis to another person or entity, 
provided that you retain no copies of the Software and the 
transferee agrees to the terms of this agreement.

• You may not:

(i) copy the documentation which accompanies the Software;

(ii) sublicense, rent or lease any portion of the Software;

(iii) reverse engineer, decompile, disassemble, modify, 
translate, make any attempt to discover the source code of the 
Software, or create derivative works from the Software; or

(iv) use a previous version or copy of the Software after you 
have received a disk replacement set or an upgraded version as 
a replacement of the prior version.

• Limited Warranty:

Liquor Monitor, LLC. warrants that the media on which the 
Software is distributed will be free from defects for a period of 
sixty (60) days from the date of delivery of the Software to you. 
Your sole remedy in the event of a breach of this warranty will be 

that Liquor Monitor, LLC. will, at its option, replace any defective 
media returned to Liquor Monitor, LLC. within the warranty 
period or refund the money you paid for the Software. Liquor 
Monitor, LLC. does not warrant that the Software will meet your 
requirements or that operation of the Software will be 
uninterrupted or that the Software will be error-free.

THE ABOVE WARRANTY IS EXCLUSIVE AND IN LIEU OF 
ALL OTHER WARRANTIES, WHETHER EXPRESS OR 
IMPLIED, INCLUDING THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT. THIS WARRANTY 
GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE 
OTHER RIGHTS, WHICH VARY FROM STATE TO STATE.

• Disclaimer of Damages:

REGARDLESS OF WHETHER ANY REMEDY SET FORTH 
HEREIN FAILS OF ITS ESSENTIAL PURPOSE, IN NO 
EVENT WILL LIQUOR MONITOR, LLC. BE LIABLE TO 
YOU FOR ANY SPECIAL, CONSEQUENTIAL, INDIRECT 
OR SIMILAR DAMAGES, INCLUDING ANY LOST PROFITS 
OR LOST DATA ARISING OUT OF THE USE OR INABILITY 
TO USE THE SOFTWARE EVEN IF LIQUOR MONITOR, 
LLC. HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.

SOME STATES DO NOT ALLOW THE LIMITIATION OR 
EXCLUSION OF LIABILITY FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGE SO THE ABOVE 
LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

IN NO CASE SHALL THE LIABILITY OF LIQUOR 
MONITOR, LLC. EXCEED THE PURCHASE PRICE FOR 
THE SOFTWARE. The disclaimers and limitations set forth 
above will apply regardless of whether you accept the Software.

• General:

This Agreement will be governed by the laws of the State of 
California. This Agreement may only be modified by a license 
addendum which accompanies this license or by a written 
document which has been signed by both you and Liquor Monitor, 
LLC. Should you have any questions concerning this Agreement, 
or if you desire to contact Liquor Monitor, LLC. for any reason, 
please write or call:

Liquor Monitor, LLC.
1300 Quail St., Suite 200
Newport Beach, CA 92660
Telephone: 1-866-202-7532
Fax: 949-477-1252
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Chapter 1 
Introducing Liquor Monitor

The Liquor Monitor is a wireless, free-pour monitoring system used to track liquor dispensing. 
You mount special spouts to the top of open liquor bottles. Later the amounts that have been 
poured are transmitted to a receiver/antenna and recorded. The recorded data can be used in a 
variety of reports that let you know what was poured and when it was poured. 

The system can be integrated with a POS system. Once integrated, you get information about 
the difference between what was poured and what was sold. You will be able to get reports that 
clearly show the accuracy and the honesty of your bartenders. See for more information about 
integrations with specific POS systems.

The Liquor Monitor package can be purchased in two variations: Liquor Monitor Stand-Alone 
and Liquor Monitor Integrated.

Stand-Alone With Liquor Monitor standalone you can monitor all your liquor pours in 
real time. Just press the button on the spout and Liquor Monitor 
automatically will enter the serial number in the database for you. Pick a 
liquor brand, put in size and cost and put the spout on the bottle...

The Liquor Monitor is not integrated with a POS system. It simply 
collects data about what was poured. Therefore, comparing the data to 
what was sold becomes a manual process.

Integrated The Liquor Monitor is “aware of” what was poured and tracks what was 
sold through a POS system. This information is presented to the user in a 
variance report that highlights any differences between what was poured 
and what was sold).

Inventory Control Liquor Monitor tracks all your liquor pours, liquor bottles, wine bottles, 
beer bottles/cans and other bar coded items. This allows you to track all 
pours and have real time visibility of your inventory. Use a handheld data 
collector programmed with Liquor Monitor software to receive inventory.



Introducing Liquor Monitor 2

Ways to Use Liquor Monitor

You can use Liquor Monitor as either a stand-alone product or an integrated system.

Stand-Alone

Requirements
• Assign spouts to liquors

What you get
• Reports on quantities of liquor poured and time poured

What you do not get
• Variance Reports showing POS sales versus amounts poured

Integrated

Requirements
• Assign spouts to liquors
• Enter drink PLUs or other POS identification numbers

What you get
• Reports on quantities of liquor poured and time poured
• Variance Reports showing POS sales versus amounts poured

Inventory Control

Requirements
• Assign spouts to liquors
• Enter inventory

What you get
• Reports on quantities of liquor poured and time poured
• Reports about inventory



Chapter 2 
Liquor Monitor QuickStart

This chapter gets you started using Liquor Monitor.

Hardware

Some customers use a one-receiver setup and hide the PC under the counter. Others use a 
multiple-receiver setup. They put the first receiver with the PC in the back office. Then they 
run wire to the bar for one or more additional receivers.

Liquor Monitor™ Pour Spout 

• Pour at any angle for total accuracy and reliability using an accelerometer 
• Patent Pending Electronics to detect removal of spout (no mechanical buttons) 
• Custom corks for all size bottles 
• No lost data due to corks rising 
• Dishwasher and Soak Safe 
• Buffer up to 48 events, no matter where the spout is located 
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Liquor Monitor™ Receiver  

The Liquor Monitor receiver is dual interface: Ethernet or Serial. It supports POE 
and has a range of up to 75'. 

It has a buffer to record pours and spout removals while it is disconnected or 
down. It also has a built in rechargeable battery pack to record pours and spout 
removals when there is no power available.

Ethernet Adapter

The Ethernet adapter 
connects the receiver / chain 
to your network

You will use either the 
Ethernet adaptor or the 
EasySYNC adaptor.

No additional wires needed.

Connecting the Ethernet Adaptor

The Ethernet adaptor is plug-n-play. You can plug it into any network using a wall outlet or an 
existing hub. It automatically obtains the IP address from your network DHCP server.

To set up the Ethernet adaptor:

1. From the computer hosting the Liquor Monitor service, select Setup>Configuration.

2. From the Port drop-down list box, select TCP/IP which causes a Config button to 
appear.

3. Click the Config button which cause the Device Configuration dialog box to open.



Liquor Monitor QuickStart 5

4. From the Device Configuration dialog box, click Search.

5. Select the devices located that will be used with Liquor Monitor (normally you select 
all of the devices).

NOTE: You almost never need to double-click a device and configure it. If you 
need to, do so with help from Liquor Monitor’s technical support team.

6. Click Program Selected Devices to program all the devices to connect to the service.

NOTE: Most systems use DNS names and there is no reason to select the 
“Advanced: Use IP not DNS” check box. If you cannot use DNS names, 
ask for help from Liquor Monitor’s technical support team.

7. Click Close.

EasySYNC Adapter

The EasySYNC adapter 
connects the receiver /antenna 
chain to the PC through a 
USB port

You will use either the 
Ethernet adaptor or the 
EasySYNC adaptor.

If you use the EasySYNC 
adaptor, you need to run wires 
to the Liquor Monitor 
stations.

Connecting the EasySYNC Adaptor

The first time you set up a Liquor Monitor station for use with the EasySYNC adaptor, it is 
best to following the step-by-step directions in the Serial Diagnostic Utility. It guides you as 
you connect the pieces to each other first and to the computer last. Later, you can assemble the 
pieces, connect the assembly to a computer and a power supply, and use the Liquor Monitor 
Configuration and Testing Utility only to test your connection. 

The pieces are:

• a USB cable with A and B ends to connect the EasySYNC adaptor to the com-
puter
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• a EasySYNC adapter with USB and serial ports
• a verifone cable (an adapter cable with one serial end and RJ14C connector) to 

connect the EasySYNC adaptor to the first receiver
• one or more receivers
• telephone wire with RJ14C connectors on each end to connect additional re-

ceivers
• a power supply with a circular plug at one end and a standard outlet plug at the 

other end (The standard outlet may come with several European and American 
plugs. You remove a plastic protector and attach the correct plug.)

• a CD from EasySYNC containing USB Serial Converter Drivers   

To hook up the hardware you have assembled to the computer:

1. If Liquor Monitor is running, stop the application.

2. Install the driver for the EasySYNC adapter.

a. Place the EasySYNC Driver CD in the CD drive of your computer.

The Easy SYNC USB Driver CD dialog appears on your screen.

b. Click the “Install Drivers” button.

c. (Optional but useful.) Click the “Installation Guides” button.

d. Click Exit.
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3. From the Start menu, select Start>All Programs>Liquor Monitor>LM Diagnostic.

The Liquor Monitor Configuration and Testing Utility window opens. 

4. Click the “I Have Not Connected Everything Yet” button.

The Steps 1-3 tab is automatically selected for you.

5. Step 1 is to ensure that the Liquor Monitor is not already running as a service, click the 
“OK, Go Ahead” button.

Step 1 becomes checked when it is OK to proceed.

6. For Step 2, unplug the USB Cable from the EasySYNC adapter if it is already con-
nected to the PC, then click the “OK, I Unplugged it” button.

Step 2 becomes checked.

7. Step 3 is to find out what COM ports are available on this computer:

a. Click the “OK, Go Ahead” button.

A message box appears with the names of the available COM ports. For example, you 
may see COM1 and COM2.

b. Write down the names of the available COM ports for later reference.

c. Click OK.
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Step 3 becomes checked.

8. Click the Next button to move on to the Steps 4-7 tab.

9. For Step 4, you:

a. Connect the B end of the USB cable to the EasySYNC adapter.

The USB port and serial port are labelled for easy assembly. The B end of the USB 
cable is trapezoidal and fits easily into the B-type USB port.

b. Insert the A end of the USB cable into one of your computer’s USB ports. 

c. Then click the “OK, it’s Connected” button.

You should see an FTDI VCP Installation dialog saying the drivers have been suc-
cessfully installed.

d. Click OK in the FTCI VCP Installation dialog.

Step 4 becomes checked.

10. For Step 5, you find out what COM port is being used. 

a. Click the “OK, Go Ahead” button.

A message box appears with the names of the available COM ports. For example, you 
may see COM1, COM2, and COM4. There will be one COM port that was not in the 
list before. In this example, it is COM4. Whatever COM port that is will be used by 
Liquor Monitor.

b. Write the new COM port number down. You no longer need that previous COM 
port numbers.

c. Click OK.

Step 5 becomes checked and the Easy Sync Comport Found box in the Status Monitor 
turns green.

11. For Step 6, the Liquor Monitor Configuration and Testing Utility updates Liquor 
Monitor .ini file and restarts Liquor Monitor as a service. Click the “OK, Go Ahead” 
button.

This is the Liquor Monitor Serial Capture service. If you check services you can see it.

Step 6 becomes checked and the Service Running box in the Status Monitor turns 
green.

12. Step 7 is about connecting the adapter cable and power supply to the EasySYNC 
adapter.

a. Connect the serial end of the adapter cable to the serial port on the adapter.

The EasySYNC adapter has the serial port labelled for easy assembly.

b. Connect the circular end of the power supply to the adapter cable.

c. Connect the power supply’s plug to a power strip.

d. Then click the “OK, it’s Connected” button.
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Step 7 becomes checked.

13. Click Next to display the Step 8 tab.

14. Step 8 is about connecting the receiver/antenna: 

a. Hold the receiver so that you can see the clear plastic circle and watch for the red 
flash of light indicating the connection is successful.

b. Connect the RJ14C end of the adapter cable to the receiver.

A red light will flash on beneath the clear plastic circle.

c. Then click the “OK, it’s Connected” button.

Step 8 becomes checked and the Antennas Indicate Powered OK box in the Status 
Monitor turns green.

15. If you have more than one receiver, connect one end of the telephone wire to the first 
receiver and the other end to the next receiver, checking for the red flash on each 
receiver.

16. Click Next to display the Test tab.

17. Now you pour from a spout a few times. Watch for the blinking data lights on both the 
receiver and the EasySYNC adapter. Do not panic. It takes a few moments to register.

If it is working, you see a smiley face on your screen, data traffic in the white window 
of the Status Monitor, and the last three boxes in the Status Monitor turns green.

The Software

There software components of Liquor Monitor are:

Liquor Monitor
The application for managing spouts, spout assignments, stations, drinks, drink 
recipes, drink ingredients, and reports.

Liquor Monitor Service
A Windows Service that runs in the background, collecting data from the receiver/
antenna and writing it to a SQL database.

Serial Diagnostic
The utility that helps you connect the hardware pieces and then connect that setup to 
the computer.

Pour Demo
A tool that demonstrates how Liquor Monitor records from a wireless, in real time, 
pour activities and spout engagements/disengagements. 
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The difference between a stand alone and an integrated system is that the PLU information for 
each drink from the POS system shows up in the integrated system.

The following figure shows the Drinks tab in Liquor Manager for a stand alone system. 
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The following figure shows the Drinks tab in Liquor Manager for an integrated system. 

The Inventory tab is part of Liquor Monitor Inventory Control. It can be purchased with either 
standalone or integrated systems.

Installing the Software

This is a short, but sufficient set of installation instructions. If you feel more comfortable with 
more pictures and detail, see “Installing Liquor Monitor” on page 116.

IMPORTANT: During the installation, there may be a long pause between 
screens while the installation application checks for the 
Windows installer and “un-packs” the installation package. 
Please be patient. There may be another pause while MSDE is 
installed.

To install Liquor Monitor:

1. Insert the CD and the installation routine should start automatically. If not, select 
setup.exe from the CD.

2. Follow the on-screen instructions until the installation finishes.
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Setting Up Liquor Monitor

To set up Liquor Monitor, you use Liquor Monitor Manager.

Starting Liquor Monitor Manager

The first time you start one of the Liquor Monitor applications, you must indicate which SQL 
Server database will be used. This information gets written to the c:\liquormonitor.ini file. 

To start Liquor Monitor Manager:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. Connect to SQL Server\Database.

The Liquor Monitor Server Login screen opens. Configure the connection screen as 
shown in the figure below. 

a. In the “Select or enter a server name” combo box, select or type the name of the 
computer followed by “\COMCASH”.

b. In the “Connection information” group box, select the “Use SQL Server authenti-
cation” option button.

c. In the “Select database on server” group box, select the “Production data” option 
button.

d. Click OK.     

Configuring Liquor Monitor

Several general options need to be set. Liquor Monitor needs to know:

• The spout type you are using



Liquor Monitor QuickStart 13

• The COM port to which your receiver is connected
• Whether you are using ounces (the U.S. measurement) or milliliters (metric 

measurement)
• The order in which you pour the drink and ring that drink up in a POS system 

(if you are using an integrated system)
• The number of minutes that can be expected between pouring and ringing up a 

drink

There are several additional options if you are integrating Liquor Monitor with a POS system. 
If you are using Liquor Monitor as a stand-alone, you can ignore the integration options.

To set general configuration options:

1. From the computer hosting the service, run Liquor Monitor Manager.

2. From the upper right of Liquor Monitor Manager’s main window, click the Setup 
menu and select Configuration.

The Configuration dialog box opens.

3. From the Spout Model drop-down list box, select LiquorMonitor or another spout 
model.

4. From the Port drop-down list box, select the port.
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If you are using Liquor Monitor hardware and ran the Liquor Monitor Configuration 
and Testing Utility, the Port drop-down list box is already correctly filled for you.

Usually, you select TCP/IP here and the Config button appears.

a. If you click the Config button, the Device Configuration dialog box opens.  

b. Click Search to locate devices.

c. Click Select All to select all the devices.

d. Click Program Selected Devices.

e. Select the “Advanced: Use IP not DNS” check box only if there is a DNS name for 
Liquor Monitor on each server. 

Talk to a Liquor Monitor technical support representative first if you plan to use DNS. 

f. Click Close.

5. If you are using the Optimus Data collector, you must indicate the serial port to which 
the cradle or infrared is connected. From the Hand Held Port drop-down list, select the 
correct COM port.

6. Select either the U.S. or Metric option buttons to measure the liquor in ounces or 
milliliters.

7. In the Standard Pour text box, type the quantity usually poured.

8. From the Match Direction drop-down list box, select one of the following:

• Pour/Ring—if you pour the drink first before recording the sale in a POS system

• Ring/Pour—if you ring up the drink and then pour it

• Either if you use no specific order
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9. In the Match Time In Minutes text box, type a number of minutes that can be expected 
between pouring the drink and ringing it up, regardless of the order of these tasks.

This is the time constraint used to match a pour to a sale. Liquor Monitor looks for the 
sale that is closest to the time of the pour, within this number of minutes, and using 
this liquor.

10. If you are integrated with a POS system, see “Integrating with POS Systems” on page 
15. The integrated options differ, depending on the POS system you use.

11. Click Close.

NOTE: When you click OK, the Liquor Monitor service restarts. You may see an 
error message about service failure for your COM port if you selected the 
wrong port or if the service is not running. Click OK to return to the 
Configuration dialog box to change the port or click Ignore to return to the 
Liquor Monitor main window.

Integrating with POS Systems

Setting up an integration between Liquor Monitor and a POS system requires three things:

• An integration file is chosen from the drop down in Liquor Monitor
• The license for LM is an integrated license, evident by the presence of the col-

umn “PLUinPOS” on the drinks screen.
• The PLU or identifier that POS refers to the drink by is entered into the 

“PLUinPOS” field.

To be integrated to a POS system, Liquor Monitor needs to extract from that POS a very small 
subset of sales data. The minimum data requirements are:

• InvoiceNo
• Lineitem
• PLU (menu item number or SKU)
• Date Time of the sale
• Additional information we like to have includes:
• Checker name
• Product Description

Liquor Monitor usually extracts this information from the host POS database via a query. 
Liquor Monitor is set up to use one of the three following methods to accomplish this:

• Read and execute a SQL text file
• Read and execute a DTS Package
• Execute a program written specifically for this purpose

Which method is used is determined by the availability of an interface to the host system and 
the complexity of the data layout. For instance, if the host database is SQL-based, a simple 
query is often sufficient. If the data is stored in a flat file or a DBF and requires a multiple-
folder search, data extraction may require a program (exe). Available programs, DTS 
packages, and executables for this purpose are stored in the LiquorMonitor directory and begin 
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with LM_. LM_DigitalDining and LM_Micros, for example, appear on the drop down list in 
the Liquor Monitor Manager under integration.

Additional information may be required to locate and read the data from the host system. For 
instance, for Micros, Liquor Monitor needs the Micros ODBC entry. For Aloha and Digital 
Dining, which store data in multiple folders, Liquor Monitor locate the folders using 
information from the .ini file.

The following sections provide information about specific POS systems.

8700

For integration to 8700, you must:

1. Use the Configuration dialog box to set integrated options. For instructions about 
reaching this dialog and setting the general options, see “Configuring Liquor Monitor” 
on page 12.

a. At the end the Integration File text box, click the browse button to locate the 
“LM_8700” file. 

Aloha

For integration to Aloha, you must:

1. Use the Configuration dialog box to set integrated options. For instructions about 
reaching this dialog and setting the general options, see “Configuring Liquor Monitor” 
on page 12.

a. At the end the Integration File text box, click the browse button to locate the 
“LM_Aloha” file. 

b. In the Data File Location text box, browse to the location where your Aloha soft-
ware data is stored. Click the browse button to locate that folder.

c. In the POS Departments List text box, do one of the following:

• To track all departments in your POS application, leave this field blank and 
select the Track All POS Departments check box.

Actually, this field will be ignored if the Track All POS Departments check 
box is selected, but leave it blank to avoid confusion.

• To track a specific subset of departments, type the numbers for those 
departments as they are numbered in your POS application. Separate them 
with a comma.

For example, suppose you want to track only shots and mixed drinks. If 
mixed drinks are assigned to department 10 and shots are assigned to 
department 11, enter “10,11” in this field.

d. In the POS Modifier Departments text box, type the numbers for the departments 
to which modifiers have been assigned.

For more about modifiers, see “Managing Modifiers” on page 29.



Liquor Monitor QuickStart 17

e. Select the Cleanup Sales Data check box if you want to clean up the drink_sales 
table that is stored in the database and appears in reports. If you are tracking 
specific departments (instead of all departments), any items from the 
departments that are not in the POS Departments List text box will be removed 
from the drink_sales table.

2. Create an environment variable named iberdir that points to the path for the data 
folders.

This environment variable is installed by Aloha. If Liquor Monitor is installed on a 
computer where Aloha has been installed, the variable should already be there. If not, 
the variable must be added.

• To create the environment variable:

a) Right click my computer and select Properties from the context menu.
b) Click Advanced
c) Click Environment Variables.
d) Click New.
e) Make an entry like:

Iberdir = Z:\Alohadata\Data 
which indicates that the root folder for aloha data is on the Z drive under 
alohadata\data

If the variable is wrong, running an integrated report results in a message saying that 
Liquor Monitor cannot find the path for the data folders. That message will also tell 
you where it is looking (that is, what the variable is set to).

COMCASH

COMCASH uses the same database as Liquor Monitor.

For integration to COMCASH POS, you must:

1. Use the Configuration dialog box to set integrated options. For instructions about 
reaching this dialog and setting the general options, see “Configuring Liquor Monitor” 
on page 12.

a. At the end the Integration File text box, click the browse button to locate the 
“LM_COMCASH” file. 

b. Ignore the Data File Location text box.

c. For directions about the POS Departments List text box, the Track All POS De-
partments check box, the POS Modifier Departments text box, and the Cleanup 
Sales Data check box, see steps c, d, and e for “Aloha” on page 16.
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Digital Dining

Digital Dining is similar to Aloha in that the data is stored in individual folders.

For integration to Digital Dining, you must:

1. Use the Configuration dialog box to set integrated options. For instructions about 
reaching this dialog and setting the general options, see “Configuring Liquor Monitor” 
on page 12.

a. At the end the Integration File text box, click the browse button to locate the 
“LM_DigitalDining” file. 

b. For directions about the POS Departments List text box, the Track All POS De-
partments check box, the POS Modifier Departments text box, and the Cleanup 
Sales Data check box, see steps c, d, and e for “Aloha” on page 16.

2. Have an entry in the LiquorMinitor.ini file (located in the root of C drive) for the loca-
tion of the data folders. For example:

[Integrated]

DataPath=E:\Digital Dining\

Again, if the path is missing or wrong, Liquor Monitor will tell you that it cannot find 
the data and where it is looking for it.

Future POS

FuturePOS uses C-Tree for its database and, therefore, requires a C-Tree ODBC driver, which 
is available at a small charge. Y

For integration to Future POS, you must:

1. Install the ODBC driver first from its CD and then install Liquor Monitor. 

Liquor Monitor looks for that driver and automatically creates the required ODBC 
settings and names. 

2. Use the Configuration dialog box to set integrated options. For instructions about 
reaching this dialog and setting the general options, see “Configuring Liquor Monitor” 
on page 12.

a. At the end the Integration File text box, click the browse button to locate the 
“LM_FuturePos” file. 

b. Ignore the Data File Location text box.

c. For directions about the POS Departments List text box, the Track All POS De-
partments check box, the POS Modifier Departments text box, and the Cleanup 
Sales Data check box, see steps c, d, and e for “Aloha” on page 16.
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Micros

For integration to Micros, you must:

1. Use the Configuration dialog box to set integrated options. For instructions about 
reaching this dialog and setting the general options, see “Configuring Liquor Monitor” 
on page 12.

a. At the end the Integration File text box, click the browse button to locate the 
“LM_Micros” file. 

b. Ignore the Data File Location text box.

c. For directions about the POS Departments List text box, the Track All POS De-
partments check box, the POS Modifier Departments text box, and the Cleanup 
Sales Data check box, see steps c, d, and e for “Aloha” on page 16.

2. Have an ODBC driver named MICROS must exist and indicate how to access the 
Micros data and where.

This ODBC entry is already installed on all Micros systems. If you are installing 
Liquor Monitor on a computer that does not have that ODBC entry, you will need to 
look at one that does to find the correct settings and then create that ODBC entry using 
admin tools.

PixelPoint

For integration to PixelPoint, you must:

1. Use the Configuration dialog box to set integrated options. For instructions about 
reaching this dialog and setting the general options, see “Configuring Liquor Monitor” 
on page 12.

a. At the end the Integration File text box, click the browse button to locate the 
“LM_PixelPoint” file. 

Running Pour Demo

Using Pour Demo is recommended.

To run Pour Demo:

1. From the Start menu, select Start>All Programs>Liquor Monitor>Pour Demo.

2. Select the U.S. or Metric button to indicate what measurements are to be used.

Assigning Spouts

You must assign each serialized spout to a specific liquor brand and, optionally, a station. If 
there are multiple stations to be monitored, you must first define each station on the Stations 
tab. Then assign spouts on the Spouts tab.
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IMPORTANT: It is a good practice to label each spout once assigned. This 
will make it easy for the spouts to find their way back to the 
correct bottle when washing.

To assign stations:

1. From Liquor Monitor Manager, select the Stations tab. 

2. Click “Add New Row”.

3. Type a number in the first column of the row.

4. Type a station name in the second column.

5. Repeat Steps 2–4 for additional stations.

6. Click Close when you are done with Liquor Monitor Manager.
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To assign spouts:

1. From Liquor Monitor Manager:  

a. Select the Spouts tab.

b. Click the Auto Refresh button, which will change from red to green.

2. “Engage” a spout by doing either of the following:

• Press the small button under the lip of the spout.

• Physically place the spout on a bottle

A new record with the spout’s serial number is automatically added to the Spouts tab. 
For example, 100AD5 might appear in the first row under SerialNo.

3. Using the Spouts tab again, select a liquor brand from the drop-down list box in the 
Liquor Brand column. 

TIP: If the liquor brand is not in the drop-down list box, go to the 
Ingredients tab to add it first.

4. Optional: Select a station from the Station drop-down list box.

5. Click Close when you are done with Liquor Monitor Manager.

TIPS: You can sort and group spouts in this tab for easy-tracking. You can sort by 
serial number, liquor brand, or station. When sorting by liquor brand, you 
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can create a custom filter by selecting Custom from the Liquor Brand 
header’s drop-down list.



and creating a filter. For more information about creating a filter, see “Sort-
ing Liquor Monitor Information” on page 56.

To manually edit spout information, click Allow Editing, update the rows, 
and click Turn Off Editing.

Running Reports

You can run reports with either live or sample data. Live data is real data that is collected by 
pouring drinks. Sample data is data provided by Liquor Monitor to show you how the report 
would look if you had real data.

To display a report:

1. From Liquor Monitor Manager, select the Reports tab. 

2. From the Report Data group box, select either the “With Live Data” or “With Sample 
Data” option button.



Liquor Monitor QuickStart 23

3. Select the report you wish to see from the “Choose a Report” list box.

4. Select the options to use as criteria for the report (Start Date, End Date, Stations, and 
so on).

Managing Employees

You will want to know who poured what and how well it was poured. To do that you must 
create an employee list, giving each employee a number, a password, and the appropriate 
access rights for using Liquor Monitor.

By default, you already have one employee with full access, the name “cc”, and the password 
“cc”. It is a good idea to make yourself the first employee and change the password to 
something that others will not know.

NOTE: You cannot delete all of the employees because if there are no employees 
in the list, no one can log in.

To add an employee:

1. From the upper right of Liquor Monitor Manager’s main window, click the Setup 
menu and select Employees.

The Configure Employee dialog box opens. You will probably need to enlarge it by 
clicking the full screen button. The full screen button has a square on it and is in the 
upper right corner next to the close button. The close button has an X on it. You can 
also drag a corner of the dialog box to increase the size of the dialog box.
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2. Click the New button to display the Configure Employee dialog box. 

3. In the Employee No text box, type a unique number for this employee.

4. In the Employee Name text box, type the employee’s name.

5. In the Password text box, type the password that the employee will use to log on to 
Liquor Monitor.

No two employees can have the same password.

6. Do one of the following:

• To give the employee full access to all Liquor Manager features, click the Full 
Access check box.

All the other check boxes becomes selected at the same time.

• To give the employee less than full access, select the appropriate check boxes.

a. Select the View Reports check box if this employee can create reports.

b. Select the Manage Employees check box to give this employee access to the 
Employees menu command in Liquor Manager. Then this employee cans add 
employees and change their access rights and passwords.

c. Select the Manage Spouts check box to give this employee access to the Spouts 
tab in Liquor Manager.

d. Select the Manage Drinks check box to give this employee access to the Drinks 
tab in Liquor Manager.

e. Select the Modify Pour Rates check box to give this employee access to the 
Pour Rates menu command in Liquor Manager.

f. Do one of the following:
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• Select the Manage Inventory check box to allow this employee to perform 
an inventory access, adjust quantities on hand for inventory items, etc. 

• Select the Edit Inventory check box to allow this employee to modify only 
descriptions and details about inventory items. When this is checked, the 
employee cannot modify quantities on hand.

• Check neither to prevent the employee from adjusting the inventory in any 
way.

7. Click OK when you are finished.

To edit information about an employee:

1. From the upper right of Liquor Monitor Manager’s main window, click the Setup 
menu and select Employees.

2. Double-click the row for the employee whose information is to be changed.

3. In the Configure Employee dialog box, make the appropriate changes.  

4. Click OK.



Chapter 3
Using Liquor Monitor Manager

The QuickStart chapter covered the Spouts and Stations features because you cannot use 
Liquor Monitor without setting up at least Spouts and your place of business is likely to have 
more than one station for serving beverages. It also explains initial configuration parameters 
and how to integrate with a POS system. See “The Software” on page 9 for those details.

This chapter covers this following:

• How to tweak the built-in pour rates if they do not work for you.
• How to set up modifiers. Anything that may cause the quantity of liquor in a 

drink to change. For example, “double” is usually a modifier.
• How to set up price brackets. Price brackets change prices for drinks when the 

the quantity of liquor is the same but some other factor, such as brand, has 
changed. For example, when a customer orders a “premium” drink, 
substituting a more expensive brand of liquor than goes into the well drink.

• How to set up Liquor Monitor departments for reporting purposes,
• How to maintain drink ingredient information
• How to use inventory information
• How to monitor sales

Modifying Pour Rates

Liquor Monitor comes with built-in pour rates for types of liquor and types of spouts. Using 
the Modify Pour Rates feature of Liquor Monitor, you can check these pour rates and adjust 
them based on the type of poured ingredient or on the spout from which the ingredient is 
poured. For example, altitude and temperature may affect the vicosity of the liquid being 
poured. Spouts can differ, too. For example they may be different brands or different batches 
from the same manufacturer. A bent spout may pour more slowly, etc.  

To check and adjust pour rates:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. From the upper right of Liquor Monitor Manager’s main window, select a location 
from the Location menu.

3. From the upper right of Liquor Monitor Manager’s main window, click the Setup 
menu and select Pour Rates.
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The Pour Rate Adjustment dialog box opens.  

4. Do one of the following:

• If you are testing/adjusting a type of liquid, select the Adjust A Type button and 
the type of liquid.

• If you are testing/adjusting a spout, select the Adjust A Spout button and the spout 
being used.
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5. Pour a known amount from a beaker using your spout.

The Amount Reported text box (upper right) indicates the poured amount recorded by 
Liquor Monitor.   

6. Do one of the following:

• If this amount is accurate, move on to the next liquid or spout.

• If this amount is not accurate, indicate the amount that really was poured by doing 
one of the following:

• Move the slider bar (next to the picture of glass tube) to the correct amount.

• Type the correct amount in the Actual Amount text box.

7. Click the Adjust By Pour button. 

The data for the type of liquid or spout will be updated according to a vicosity for-
mula.

8. Click the Close button when you are finished.

In earlier versions of Liquor Monitor, a different method of adjusting pour rates was used. This 
is still available for customers who prefer it, but it is not recommended.

To adjust a pour rate using a numeric value:

1. From the Pour Rate Adjustment dialog box, select the Adjust A Type or Adjust a 
Spout button.

2. Select a liquid or a spout.

3. Click the Adjust By Fixed Amount button.  
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The Fixed Adjustment dialog box opens.  

4. Type a positive number or a negative number that will be used to adjust the pour rate 
for the selected liquid or spout. 

For example, you might want to set one liquid to the same number as another similar 
liquid by entering the current difference between them.

5. Click OK to return to the Pour Rate Adjustment dialog box.

To adjust a pour rate using a numeric value:

1. From the Pour Rate Adjustment dialog box, select the Adjust A Type or Adjust a 
Spout button.

2. Select a liquid or a spout.

3. Click the Adjust By Percentage button. 

The Percentage Adjustment dialog box opens.  

4. Type a positive number or a negative number that will be used as a percentage for 
adjust the pour rate for the selected liquid or spout. 

For example, if a spout appears to be pouring twice as much as is really being poured, 
you might want to half the rate by entering -50%.

5. Click OK to return to the Pour Rate Adjustment dialog box.

Managing Modifiers

An important part of setting up Liquor Monitor is to specify modifiers by name and their effect 
on the quantity of liquor sold. Anything like a “double” or “shot” that may cause a drink’s 
price and or quantity to change is considered a modifier.
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Generally, the modifiers are defined in two places, in POS for pricing and in Liquor Monitor 
for quantity. In your POS application, you usually set up a department for monitors. Liquor 
Monitor uses that department to locate monitors. However, while the POS entry indicates the 
price difference, it does not indicate how much extra liquor to pour. You set up this 
information in Liquor Monitor using the steps below.

For example, suppose you create a modifier named “double”. When you ring up a double, 
Liquor Monitor understands that an additional amount of liquor is being poured, and does not 
report that amount as an overpour.

Internally, when a modifier is selected for a drink, Liquor Monitor adjusts the line preceding it 
in the sales table. It changes the quantity and/or price and changes the description to include 
the modifier text. Then Liquor Monitor deletes the modifier line. 

For example, suppose that a screwdriver is normally made with house vodka, costs $5.00, and 
uses 1.5 ounce of liquor. It shows up as one line item in the drink_sales table.

If a bartender rings up a screwdriver and then selects the double key and the premium liquor 
key, the line in the drink_sales table will read "Screwdriver, double, premium", the priceAdj 
field shows the extra charge (for example, $2.00, and the qtyAdj field shows that there is an 
additional 1.5 ounces of liquor (given this screwdriver was a double).

NOTE: If you have integrated with a POS system (see “Integrating with POS Systems” 
on page 15) and filled the POS Modifier Departments text box, the Modifiers 
dialog box will list the items in that department. If you have not filled that text 
box and are integrated with a POS system, fill it now. That may mean that you 
have to go back to your POS system and create that department.

To set up modifiers:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. From the upper right of Liquor Monitor Manager’s main window, select a location 
from the Location menu.

3. From the upper right of Liquor Monitor Manager’s main window, click the Setup 
menu and select Modifiers.
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The Modifiers dialog box opens. 

If you have a modifiers department in your POS system, this dialog box should 
already list those modifiers. You need to edit each one to indicate the quantity of extra 
liquor poured when that modifier is applied. 

If Liquor Monitor is not integrated with a POS system, you must add all the modifiers 
and indicate the extra quantity of liquor poured for each. Providing a description is a 
good idea as some modifiers may be similar in name but pour different quantities.

4. Do any of the following:

• Add a modifier:

a) Click Add New Row.
b) When the row appears in the dialog box, add text to the fields in the row.

• Delete a modifier:

a) Place your cursor in the row to be deleted. 
b) Click Delete Row.

• Edit a modifier:

a) Place your cursor in the row and column to be edited.
b) Change the information in the field.

5. Click Close.

Managing Price Brackets

Price brackets have to do with premium, house, well, and call liquors. Each bracket has a 
different price level. Suppose that a drink normally contains Smirnoff (the house vodka) and 
cost $4.50. However, the customer asks for "Stoli" (which is a premium liquor). Liquor 
Monitor needs to know how much to change the price. If a premium liquor is used but the 
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customer is only charged for a well drink, this information will appear on the Substitution 
report, recording when you gave away the premium liquor at base cost.

To set up price brackets:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. From the upper right of Liquor Monitor Manager’s main window, select a location 
from the Location menu.

3. From the upper right of Liquor Monitor Manager’s main window, click the Setup 
menu and select Price Brackets.

The Price Brackets dialog box opens.

4. Do any of the following:

• Add a price bracket:

a) Click Add New Row.
b) When the row appears in the dialog box, add text to the fields in the row.

• Delete a price bracket:

a) Place your cursor in the row to be deleted. 
b) Click Delete Row.
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• Edit a price bracket:

a) Place your cursor in the row and column to be edited.
b) Change the information in the field.

5. Click Close.

Managing Departments

Departments in your POS system and departments in Liquor Monitor are not necessarily the 
same.

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. From the upper right of Liquor Monitor Manager’s main window, select a location 
from the Location menu.

3. From the upper right of Liquor Monitor Manager’s main window, click the Setup 
menu and select Departments.

The Departments dialog box opens.  

4. Do any of the following:

• Add a department:

a) Click Add New Row.
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b) When the row appears in the dialog box, add text to the fields in the row.

• Delete a department:

a) Place your cursor in the row to be deleted. 
b) Click Delete Row.

• Edit a department:

a) Place your cursor in the row and column to be edited.
b) Change the information in the field.

5. Click Close.

Maintaining Drink Information

Liquor Monitor comes with initial drink recipes and ingredient lists. You may want to make 
recipe changes to house specialties. You may want to add and delete drinks or ingredients. You 
may want to adjust the ingredients and amounts in existing drinks.

See “Sorting Liquor Monitor Information” on page 56 for details about sorting information.

Adding a Drink

You use Liquor Monitor Manager’s Drinks tab to add a drink. For example, you may have a 
house specialty that is not in the list.

To add a drink:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. From the upper right of Liquor Monitor Manager’s main window, select a location 
from the Location menu.
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3. Select the Drinks tab.  

Because you will be created a new drink, you may want to check drink IDs so that you 
don’t accidentally create a duplicate.

Sorting by drink name may be a good idea, too. You may want to check that a drink 
with the same name as your new drink is not currently in the list.

4. Click Add/Edit.
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The Drink Maintenance dialog box opens and displays the currently selected drink. 

If you are integrated with a POS system, there is an additional box next to the Drink 
ID for the PLU.

5. Click the New button at the bottom.

The Drink Maintenance dialog box empties, except for a “1001-” in the Drink ID text 
box.   

6. Type an identification number in the Drink ID text box.

You may want to add to the “1001-” or create an entirely new number. Each drink 
must have a unique number.
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7. Type a name in the Drink Name text box.

8. (Optional) Make a list of ingredients for this drink.

a. Double-click an ingredient from any of the lists and a new row appears in the In-
gredients box at the left.

It is best to double-click the ingredients in the order that they should be added to the 
drink, but you can resequence them later (by changing the Seq number in the 
Ingredients box) if you make a mistake.

b. Edit the amount and measure by typing in the Amount and Measure fields in the 
Ingredients box.

c. Repeat steps a and c for all ingredients.

9. Click Close when you have finished.

Changing a Drink

You may want to change the directions or ingredients for a drink that is already listed in Liquor 
Monitor Manager.

To locate the drink to be changed:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. From the upper right of Liquor Monitor Manager’s main window, select a location 
from the Location menu.

3. Select the Drinks tab.

4. Locate the drink in the list and double-click it.

The Drink Maintenance dialog box displays all the information currently stored for 
this drink. You can type the first few letters in the Lookup Drink text box to locate the 
drink quickly.

To change the amount or measure of an ingredient:

• Change the values in the Amount and/or Measure fields for that ingredient in 
the Ingredients box.

To delete an ingredient:

1. Select the ingredient from the Ingredients list.

2. Click Delete Ingredient.
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To add an ingredient:

1. Click Add Ingredient.

The right side of the dialog box changes. It displays lists named: Liquor Types, Spe-
cific Liquor, and All Other Ingredients.

2. Double-click an ingredient from any of the lists and a new row appears in the Ingredi-
ents box at the left.

3. Edit the amount and measure by typing in the Amount and Measure fields in the 
Ingredients box.

To save your changes:

• Click Close.

Reviewing Ingredients Information

The ingredients lists indicates all the ingredients used in drinks. To assist you in locating 
ingredients, Liquor Monitor Manager adds additional sorting features to the Ingredients dialog 
box.

See “Sorting Liquor Monitor Information” on page 56 for details about sorting. You can also 
sort and group ingredients using the following methods:

• Use the option buttons (Show All Items, Show All Liquors, and Show Only 
Spouted Items) for an initial sort.

• You can locate ingredients by typing the first few letters in their names in the 
Lookup Ingredient text box.

• You can drag one or more column header to a location above the others. This 
groups the data by values in the column headers. Plus and minus buttons appear 
before the names of groups, allowing you to display or hide the rows in each 
group.
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For example, the following figure shows ingredients sorted by the Show All Items 
option button and a series of letters. 
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The following figure shows ingredients sorted by the Show All Liquors option button 
and a series of letters.
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For example, the following figure shows ingredients sorted by a series of letters and 
by liquor type. 

The next figure shows ingredients sorted by letters, types, and subtypes.  
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Adding an Ingredient

You can add ingredients if the list that comes with Liquor Monitor is not sufficient. After you 
add an ingredient, it will be displayed in the list of general ingredients (on the Ingredients tab) 
and can be displayed in the ingredient list for any number of drinks.

To add an ingredient:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. From the upper right of Liquor Monitor Manager’s main window, select a location 
from the Location menu.

3. Select the Ingredients tab.  

4. Click Allow Editing.

5. Click Add New Row.

The New Ingredient dialog box opens.

6. Type the ID or PLU for this ingredient in the ID/PLU field.

A new row is added to the end of the list.
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If you are using a PLU and a POS system, the cost and sales price fields (see Steps 9 
and 10) can be filled in automatically.

7. Type a name in the Product Name field.

8. Select a department for this ingredient:  

a. Place the cursor in the Dept field.

b. Click the down-arrow button inside that field (not inside the column header) to dis-
play a list of departments.

c. Select a department. 

For example, you might select Juices.

TIP: If you know the department, you can type its first few letters in the 
Dept field. Press Enter when the type you want appears in the 
field.

9. Fill in all the fields in the row.

Many fields have drop-down lists. The Cost and Price fields may be filled automati-
cally by a POS system.

10. Click Turn Off Editing when you have finished editing.
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Changing an Ingredient

You can edit the information about an ingredient at any time.

To change the information about an ingredient:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. From the upper right of Liquor Monitor Manager’s main window, select a location 
from the Location menu.

3. Select the Ingredients tab.  

4. Select the row for the ingredient to be changed.

5. Click Allow Editing.

6. Type your changes in the appropriate fields.

7. Repeat step 5 for other ingredients.

8. Click Turn Off Editing when finished.

To delete an ingredient:

• Once you have selected the row for the ingredient, click Delete Row.

Using Reports

Liquor Monitor Manager comes with the following reports:

• Brand Pour Detail
• Brand Pour Summary
• Consumption
• Engage/Disengage
• Inventory Movement Detail
• Inventory Movement Summary
• Pour Cost
• Pour Log
• Pour Retail Price
• Unassigned Spout Report

Reports integrated with the POS are:

• Audit
• Cost of Sales
• Discrepancies
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• GiveAways
• Inventory Value
• MisMatches
• OverPours
• Pours Not In Sales
• Sales and Pour Summary
• Sales by Drink Type
• Spout Assignment
• Substitutions
• Variance by Cashier
• Variance by Drink Type 
• Variance by Liquor Detail
• Variance by Liquor Summary

    

To run a report:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. From the upper right of Liquor Monitor Manager’s main window, select a location 
from the Location menu.

3. Select the Reports tab. 

4. From the “Choose a Report” list, select the type of report.
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5. Select “With Live Data” or “With Sample Data” from the Report Data box.

Normally you will use live data for your place of business. Sample data is used for 
practice.

6. Choose the appropriate options:

a. Select a start date and time for the report.

b. Select an end date and time for the report.

For example, you might run daily or weekly reports.

c. From the Locations drop-down list box, select a location or select All to run the 
report for all locations.

d. From the Stations drop-down list box, select a station by name or select All to run 
the report for all stations.

e. From the Liquor Types drop-down list box, select one or all liquors to be accounted 
for in the report.

f. From the Brands drop-down list box, select a one or all brands to be accounted for 
in the report.

g. From the Spouts drop-down list box, select a one or all spouts to be accounted for 
in the report.

h. For some reports, you can use the Pour Amount Cutoff and Variance Cutoff text 
boxes. This amounts must be provided in ounces but they can be reported on in 
milliliters.

Pour Amount Cutoff applies to the Pour Cost, Pour Log, Brand Pour Detail, and Brand 
Pour Summary reports. For example, you may not be interested in pours per drink that 
are smaller than 1 ounce.

Variance Cutoff applies to the Variance Reports. For example, you may not be 
concerned about pours that are less than .2 ounces over-poured.

If appropriate for your report, do one of the following:

• In the Pour Amount Cutoff text box, type the minimum size of pour to be included 
in the report. Smaller pours are ignored. You enter the size in ounces or milliliters 
(depending on whether you are using U.S. or metric measures).

• In the Variance Cutoff text box, type the smallest amount of over-pouring to be 
reported.

i. If Liquor Monitor is integrated with a POS system, check the Get Latest Sales Data 
check box to access the POS system for the latest sales.

Clear this check box, for example, if you have recently run this report and are 
expecting no changes in the sales data.

7. Click Run Report (above the options portion of the dialog box).

The following sample reports help you decide what reports will be of the most benefit to you.  
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Brand Pour Detail Report  
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Consumption Report 
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Engage / Disengage Report 
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Pour Log Report 
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Discrepancies Report

Giveaways Report
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Mismatches Report

Overpours Report
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Sales and Pour Summary Report
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Substitutions Report 
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Variance Report by Cashier 
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Variance Report by Drink Type

Sorting Liquor Monitor Information

You can sort information in any part of Liquor Monitor Manager.

To sort the information in a column:

• Click a column’s header to sort that column’s information in alphanumerical 
order. Click it again to sort in reverse alphanumeric order. For example, you 
sort drinks by their IDs, names, glass types, and directions. 

To limit the number of rows displayed based on the value in a column:

1. Click the down-arrow button in the column header.  



Using Liquor Monitor Manager 57

For example, clicking the button in the column header for Liq.Type displays a list of 
liquors and other ingredient types. In that list are also selections named All and Cus-
tom.

2. Click the appropriate item in the list.

For example, if you select Garnish, all the ingredients that are garnishes and only 
those ingredients will be displayed. If you select All, the entire list will be displayed. 
If you select Custom, the Custom Filter dialog box opens.

NOTE: The drop-down lists for some of the column headers include Blanks 
and NonBlanks. Select Blanks to locate the rows for which the 
selected column is empty. Use NonBlanks to exclude rows for which 
the column is empty.  

To use a custom filter:

1. Click the down-arrow button in the column header to display a drop-down list.

2. Select Custom from that list.

3. Create your own criteria for what should be displayed.

For example, you can display all the ingredients that are considered garnishes at the 
same time as all the ingredients that are considered spices and flavorings.  

You can use wildcards. Use an underscore to represent any one character. Use % to 
use any series of characters.

Once the filter is applied, you see information about the filter in the lower-left area of 
the screen. For example, the filter described above results in: 

You also see a Customize button in the lower-right area of the screen. 
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4. You can use the Customize button to edit the custom filter or save it for reuse. For 
example, you may want to include other columns in the filter. Or, you may have made 
an error, such as using AND when you really wanted OR, and want to correct it.   

To save the custom filter:

a. Click the Customize button.

The Filter Builder dialog box opens.

b. Click Save As.

The Save The Active Filter To File dialog box opens. 

c. Type a name for the filter in the File Name text box. (Keep the .flt extension.)

To reuse a saved custom filter:

a. Click the Customize button.

The Filter Builder dialog box opens.

b. Click Open.
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The Open An Existing Filter dialog box opens. 

c. Select the saved filter to reuse. (It’s extension should be .flt.)

To edit the custom filter that is currently in use:

a. Click the Customize button.

The Filter Builder dialog box opens.  

b. Modify the filter to suite your needs.

AND and OR are called logical operators and group conditions together. AND means 
that a match occurs if all the conditions in the group are met. OR means that a match 
occurs if any of the conditions in the group are met. A third logical operator is NOT. 
NOT AND and NOT OR are the opposite of AND and OR. They match everything 
that would not have been a match for the group of conditions that were ANDed or 
ORed.

Rows like “LIQ. TYPE equals Garnish” are conditions.

Clicking on the Filter box displays a drop-down menu with the commands “Add 
Condition”, “Add Group”, and “Clear All”.  

Clicking on one of the ... boxes displays a drop-down menu with the commands “Add 
Condition”, “Add Group”, and “Remove Row”. If you select a row with a logical 
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operator, you remove the entire group. If you select a row with a condition, you 
remove just that row.   

Clicking on a logical operator displays a drop-down menu that allows you to change 
the operator.  

To edit a condition, you click any of its three parts. The first part is the name of the 
column, the second part is a conditional operator (such as equals), and the third part is 
a value that may or may not be found in the selected column.  

Clicking “press the button to add a new condition” adds a new condition just above 
the button. Then you must click each of the three parts of the condition (the column, 
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conditional operator, and value) to make appropriate selections. Sometimes you have 
to type in the third part (the value) because text fields do not have drop-down lists.    

If your query has only one condition, the default state of the Filter Builder dialog box 
still shows the logical operator AND. There is nothing being ANDed, but it allows the 
filter to be displayed in a format you can edit.     

c. Click OK to exit with the new filter or Apply to try out the new filter without exit-
ing the Filter Builder dialog box.

Monitoring Sales

You can monitor sales in the following ways:

• Live
• For today or any given day
• For all time

Monitoring Sales Live
Monitoring sales as they happen is great fun but View Live can also help you trouble-
shoot the system, fixing problems with unmatched pours and sales. 

Reviewing sales live helps you match the unmatched or at least identify candidates. 
For example, suppose a Kahlua pour at happened at 10:34 p.m. and a White Russian 
sale happened at 10:35 p.m. but they both show as unmatched. Examination of the 



Using Liquor Monitor Manager 62

drinks list may indicate the drink White Russian contains NO ingredients, not even 
Kahlua! The ingredients for this drink need to be corrected.

To view pours and sales as they happen:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. From the upper right of Liquor Monitor Manager’s main window, select a location 
from the Location menu.

3. Select the View Live tab.

4. To see what items are being matched by Liquor Monitor, click the Match button, 
which runs the matching engine so you can see sales and pours that are matched to one 
another as they happen.

To manage unmatched pours and sales:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. From the upper right of Liquor Monitor Manager’s main window, select a location 
from the Location menu.

3. Select the View Live tab.

The top grid shows pours, the bottom grid shows sales. 

4. Select an unmatched pour from the top grid.

Liquor Monitor filters the bottom grid to show all sales that took place in a window 
around that pour.

5. Control the number of minutes examined around the time of the pour by clicking the 
“10 Min”, “20 Min”, “30 Min” or “All” buttons. 

“All” shows all sales since you installed Liquor Monitor. The default is “20 Min”.

6. Determine any patterns and decide what drinks to check ingredients for.

Checking Sales for a Specific Day or All Days

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. From the upper right of Liquor Monitor Manager’s main window, select a location 
from the Location menu.
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3. Select the Sales tab.

4. Do one of the following:

• To see today’s sales, click the Today button.

• To see a specific day’s sales:

a. Click the button at the end of the Specific Date drop-down list box to display 
a calendar.

b. Select a date from the calendar.

• To see all sales since you installed Liquor Monitor, click the All button.

Maintaining Inventory Information

The inventory provides information about the ingredients used in drinks, such as the quantity 
on-hand at each location. To assist you in locating ingredients, Liquor Monitor Manager adds 
additional sorting features to the Ingredients dialog box. 

Transferring Inventory from One Location to Another

It is easy to transfer liquor from one location to another (at least in the database). The 
Inventory tab shows the amount of each liquor at each location. For example, if the Cabana 
location has run out of Samuel Adams and the Blush location has more than enough, you 
might transfer 11 bottles from Blush to Cabana.  



Using Liquor Monitor Manager 64

To transfer inventory from one location to another:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. Select the Inventory tab. 

3. Double-click the item to be transferred.

Use the From/To dialog box to specify the direction, quantity, and reason for the trans-
fer.  

4. From the From drop-down list box, select the supplying location.

5. From the To drop-down list box, select the receiving location.

6. Type the quantity in the spin box.

You can use the spin buttons to adjust the quantity.

7. Type a reason in the Reason/Note text box.

8. Click OK.
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The information about the transfer appears in the Transfer List on the Inventory tab.  

9. Click Preview Report to display and/or print the transfer order.  

10. When the transfer is confirmed, click Accept And Post Changes to update the columns 
in the database for each transferred item.

TIPS: Click Save Transfer Sheet to store the current transfer list for later 
updates. Click Recall Transfer Sheet to select a saved transfer list 
to continue working on it.

To delete rows from an unposted transfer list, select the rows and 
press the Delete button on your keyboard. Click Clear And Start 
Over to get rid of all the rows in the transfer list.
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The rows in the transfer list can be filtered using the From 
Location button.

Manually Adding Inventory to a Location

When a location receives a shipment of liquor, you can input that information manually. The 
following procedure can also be used to update actual inventory after counting all the liquor at 
a location.

To manually update inventory for one location:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. Select the Inventory tab.

3. Double-click the item to be updated.

Use the From/To dialog box to specify the quantity and a note about the shipment.

4. Ignore the From drop-down list box.

5. From the To drop-down list box, select the receiving location.

6. Type the quantity in the spin box.

You can use the spin buttons to adjust the quantity.

7. Type a note in the Reason/Note text box.

8. Click OK.

The information about the received merchandise appears in the Transfer List on the 
Inventory tab.

9. Click Preview Report to display and/or print the list.

10. When the merchandise has been stocked, click Accept And Post Changes to update 
the columns in the database for each transferred item.
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TIPS: Click Save Transfer Sheet to store the current transfer list for later 
updates. Click Recall Transfer Sheet to select a saved transfer list 
to continue working on it.

To delete rows from an unposted transfer list, select the rows and 
press the Delete button on your keyboard. Click Clear And Start 
Over to get rid of all the rows in the transfer list.

The rows in the transfer list can be filtered using the From Loca-
tion button.

Printing an Inventory Log

To support the paper and pencil method of inventorying stock, print an inventory log.  

To print the log:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. Select the Inventory tab.

3. Click Print.

A Print Preview window displays the items currently under inventory control.

4. Select File>Print.

Sending an Inventory File to a Handheld Device

You can send the inventory list as displayed in the Inventory tab to a handheld inventory 
device.
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To download inventory information:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. Select the Inventory tab.

3. Sort and group the data as appropriate.

4. Click Send To Handheld.

The Download Lookup dialog box opens.  

5. Do one of the following to fill the File Name text box:

• Use the default file name (InvToHH.txt).

• Click Browse to select a file name.

• Edit the text box to provide a file name.

6. From the Download Via list box, select the method of download: Cradle-IR, 
RS232 or IrDA, or MODEM.

7. In the COM Port list box, type a port number.

8. From the Baud Rate list box, select the bits-per-second (bps): 9600, 19200, 
38400, 57600, or 115200.

9. Click Configure

10.Click OK.

Receiving Inventory Information from a Hand-held Device

With the hand-held inventory device, you scan the barcodes on incoming merchandise. 
Then you can upload that information to Liquor Monitor.
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To upload inventory information:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. Select the Inventory tab.

3. Click Send To Handheld.

The Hand Held Receiving dialog box opens. 

4. Fill in the fields and click OK.

TIP: Click Recalc Inventory to refresh the data in the Inventory tab.

Importing an Inventory File

To use this procedure, you must have an inventory file in an Excel spreadsheet, with 
columns that match the Liquor Monitor inventory.

Make sure that the file has been copied to a location that the computer can access.

To upload inventory information from an inventory file:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. Select the Inventory tab.

3. Click Import Inventory.

4. Browse for the file to be imported.

5. Click Open.

The items are listed in the Inventory tab along with their quantities.

TIP: You can import requisitions using the same procedure, clicking 
the Import Requisitions button instead of the Import Inventory 
button.

Click Recalc Inventory to refresh the data in the Inventory tab.

Reviewing Inventory History

To review the inventory movements performed in the Inventory tab, you use the Show History 
and Close History buttons.
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To review inventory movement history:

1. Start the Liquor Monitor Manager from the Start menu by selecting Start>All 
Programs>Liquor Monitor>Liquor Monitor. 

2. Select the Inventory tab.

3. Click Show History.

The Transfers List is replaced with the Inventory Movement History.

The new list can be grouped by dragging column headers (in the appropriate 
sort order) upward to the area just below the Inventory Movement History title.

4. Click Close History to return to the Transfer List.

 



Chapter 4
Using the Utilities

Liquor Monitor comes with database utilities that allow you to perform a number of 
operations, such as backing up your database or uploading it for Liquor Monitor technical 
support.

To use the utilities:

1. Do one of the following:

• From the Start menu, select Liquor Monitor Utilities.

• Select the ccSQLUtilities icon on your desktop. 

The password entry dialog box appears.  

2. Select a server from the Select A Server Name drop-down list box.

3. Indicate the type of authentication by selecting either the Use Windows NT Authenti-
cation or the Use SQL Server Authentication option button. The SQL server authenti-
cation is recommended.

4. Type your user name and password in the appropriate text boxes.

5. Click OK.

The Liquor Monitor SQL Utilities window displays a tree of servers, showing the 
databases on the server and the tables in each database. The following figure shows 
one server (Liquor Monitor-LT\Liquor Monitor) and a series of database (those usu-
ally installed with Liquor Monitor Manager. Each database can be expanded to show 
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its tables. As you change the selection from a server to a database or a table, 
some of the menu items can the toolbar buttons change.    

 Using the Menus and Toolbars
Liquor Monitor Utilities offer a variety of database aids for both databases and their 
tables. When you select a server, database or table, some of the menu commands and the 
toolbar buttons change.
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File Menu

The File menu always has the same commands, regardless of your selection from the 
tree in the left pane of the Liquor Monitor SQL Utilities window.     

Commands Menu

The commands on the Command menu change depending on your selection of the 
database server, a database, or a table.

Command Description

Run Service Control Manag-
er

Displays SQL Server Service Manager dialog box from 
which you can start, pause, and stop a database server.

Change Manager Password Allows you to change your password to Liquor Monitor 
Manager and the Liquor Monitor Utilities.

Check Program Versions Lists the dates, times, and version numbers for executable 
files.

Attach Database Allows you to attach an MDF file as a database to be man-
aged by the database server.

Exit Ends this session.
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Database Server Commands

The following figure lists the commands on the Commands menu when the database 
server is selected.    

Database Commands

The following figure lists the commands on the Commands menu when a database is 
selected.   

Command Description

Log On to SQL Server Displays the Connect to SQL Server dialog box so you can 
change the database server currently being used by the util-
ities.
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Command Description

Backup Manager Displays the Manual Backups for Liquor Monitor dialog 
box and allows you to perform backup and restore opera-
tions.

SQL Query Interface Allows you to run SQL queries of your own. This should be 
done only with supervision from Liquor Monitor technical 
support.

Set Modified Flags in One or 
More Tables

Modified flags are what tell polling systems if the row of 
data has been modified since the last replication. Occasion-
ally, with the advice of Liquor Monitor Technical Support, 
you may need to set flags in one or more tables.

Clear Modified Flags in One 
or More Tables

Modified flags are what tell polling systems if the row of 
data has been modified since the last replication. Occasion-
ally, with the advice of Liquor Monitor Technical Support, 
you may need to clear flags from more or tables.

Delete Location Allows you to delete a location from the database.

Change Location Allows you to change the number for a location in the data-
base.

Detach Database Allows you to detach the database from the database serv-
er’s control.

Count Rows Displays a report of all the tables in the selected database, 
indicating the number of rows in each table.

Empty Tables Allows you to empty the table, deleting its contents.

Go Live! Allows you to replace the current Liquor Monitor database 
with another one that you have created.
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Database Table Commands

The following figure lists the commands on the Commands menu when a database table 
is selected.   

Command Description

View Table Contents Displays the selected table in contents order. Each row is a 
record containing a value for each column in the table.

View Table Structure Displays the selected table in structural order. There is a 
row for each column and its internal properties, such as col-
umn number, name, type, length and so on.

Clear Modified Flags Modified flags are what tell polling systems if the row of 
data has been modified since the last replication. Occasion-
ally, with the advice of Liquor Monitor Technical Support, 
you may need to clear flags from the selected table.

Set Modified Flags Modified flags are what tell polling systems if the row of 
data has been modified since the last replication. Occasion-
ally, with the advice of Liquor Monitor Technical Support, 
you may need to set flags in the selected table.

Import Data Allows you to import the data from a CSV list. Each line of 
the text file must be a comma-separated set of values which 
becomes a content row in the table.

Export Data Allows you to export the data from a table to a CSV list. 
Each content row because a comma-separated set of values 
on a line of a text file.

Clear Table Allows you to delete the contents (rows) of the selected ta-
ble.
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Help Menu

The Help menu always has the same commands.    

General Toolbar

This toolbar corresponds to the File menu and does not change with your selection from 
the tree in the left pane of the Liquor Monitor SQL Utilities window. It does not change 

SP Helper Stored Procedure (SP) Helper contains strings commonly 
used in stored procedures. Liquor Monitor technical sup-
port may advice you to create stored procedure. If so, these 
strings will save you some typing.

Query for All Allows you to display all the rows in a table rather than the 
first 200.

Print Allows you to print the contents of the database.

Command Description

Check for Update Allows you to update the current copy of the Liquor Moni-
tor Utilities with the latest executable files from Liquor 
Monitor. You must be able to connect to the Internet from 
this computer to take advantage of the updates.

About SQL Utilities Lists the version number and other information about Li-
quor Monitor Utilities.

Command Description
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with your selection from the tree in the left pane of the Liquor Monitor SQL Utilities 
window.    

Database Toolbar

The following figure shows the toolbar that appears when you have selected a database 
from the tree in the left pane of the Liquor Monitor SQL Utilities window.    

Command Description

Run Service Control Manag-
er

Displays SQL Server Service Manager dialog box from 
which you can start, pause, and stop a database server.

Change Manager Password Allows you to change your password to Liquor Monitor 
Manager and the Liquor Monitor Utilities.

Check Program Versions Lists the dates, times, and version numbers for executable 
files.

Attach Database Allows you to attach an MDF file as a database to be man-
aged by the database server.

Command Description

Go Live! Allows you to replace the current Liquor Monitor database 
with another one that you have created.

Empty One or More Tables 
in the Database

Allows you to empty one or more the database’s tables, de-
leting their contents.

Display Row Counts for All 
Tables in Database

Displays a report of all the tables in the selected database, 
indicating the number of rows in each table.

Detach Database Allows you to detach the database from the database serv-
er’s control.

Change Location Allows you to change the number for a location in the data-
base.

Delete Location Allows you to delete a location from the database.



Using the Menus and Toolbars 79

Table Toolbar

The following figure shows the toolbar that appears when you have selected a database 
table from the tree in the left pane of the Liquor Monitor SQL Utilities window.    

Set Modified Flags in One or 
More Tables

Modified flags are what tell polling systems if the row of 
data has been modified since the last replication. Occasion-
ally, with the advice of Liquor Monitor Technical Support, 
you may need to set flags in some tables.

Clear Modified Flags in One 
or More Tables

Modified flags are what tell polling systems if the row of 
data has been modified since the last replication. Occasion-
ally, with the advice of Liquor Monitor Technical Support, 
you may need to clear flags from some tables.

SQL Query Interface Utility Allows you to run SQL queries of your own. This should be 
done only with supervision from Liquor Monitor technical 
support.

Backup Manager Displays the Manual Backups for Liquor Monitor dialog 
box and allows you to perform backup and restore opera-
tions.

Command Description

Print Allows you to print the table.

Query Table for All Rows Allows you to display all the rows in a table rather than the 
first 200.

Database In Read-only Mode 
Database In Read/Write 
Mode

Allows you to toggle between read-only and read/write 
states so that you can edit table values.

SP Helper Stored Procedure (SP) Helper contains strings commonly 
used in stored procedures. Liquor Monitor technical sup-
port may advice you to create stored procedure. If so, these 
strings will save you some typing.

Clear Table Allows you to empty the contents of the selected table.

Export Data Allows you to export the data from a table to a CSV list. 
Each content row because a comma-separated set of values 
on a line of a text file.

Command Description
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Starting a SQL Server Database Server
If SQL Server (or MSDE) is not already running the database server you wish to work 
with (for example the Liquor Monitor database server), you can start that server 
combination.

To start a database server:

1. From the Liquor Monitor SQL Utilities window, do one of the following:

• Select File Run Service Control Manager from the menu bar.

• Select the Run Service Control Manager button on the toolbar.

Import Data Allows you to import the data from a CSV list. Each line of 
the text file must be a comma-separated set of values which 
becomes a content row in the table.

Clear Modified Flags Modified flags are what tell polling systems if the row of 
data has been modified since the last replication. Occasion-
ally, with the advice of Liquor Monitor Technical Support, 
you may need to clear flags from the selected table.

Set Modified Flags Modified flags are what tell polling systems if the row of 
data has been modified since the last replication. Occasion-
ally, with the advice of Liquor Monitor Technical Support, 
you may need to set flags in the selected table.

View Table Structure Displays the selected table in structural order. There is a 
row for each column and its internal properties, such as col-
umn number, name, type, length and so on.

View Table Contents Displays the selected table in contents order. Each row is a 
record containing a value for each column in the table.

Command Description
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The SQL Server Service Manager dialog box opens.  

If the arrow is red, the server has been stopped. You want to change the arrow to 
green, as in the figure above.

2. The Server drop-down list box should display the computer name (for example, 
Liquor Monitor-LT in the above figure) followed by “\Liquor Monitor”, the 
name of the database server. If it does not appear, select it.

3. If SQL Server does not appear in the Services drop-down list box, select it.

4. Select the “Auto-start service when OS starts” check box if appropriate.

5. Click the Start/Continue button.

The icons in the dialog box should change to display a green arrow and that same 
icon should appear in the system tray at the lower right of your monitor screen.   

TIP: Use this dialog box to pause or stop the database server as 
well. 

Using SQL Queries
Never run SQL Queries on Liquor Monitor databases without supervision from Liquor 
Monitor technical support. Using this utility without that supervision may invalidate 
your support contract.

To use a SQL query:

1. From the Liquor Monitor SQL Utilities window, select a database.
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2. Do one of the following:

• Select Commands SQL Query Interface from the menu bar.

• Click the SQL Query Interface button on the toolbar.

A warning box appears.    

3. If you are being supervised by Liquor Monitor technical support, click Continue. 

Checking the Versions of Your 
Executable Files

If you are contacting Liquor Monitor technical support, you might be asked which 
version you have of an executable that is malfunctioning.

To check the versions of executable files:

1. From the Liquor Monitor SQL Utilities window, do one of the following:

• Select File Check Program Versions from the menu bar.

• Select the Check Program Versions button on the toolbar.
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The Liquor Monitor Executables Version Information dialog box opens.  

2. Do one of the following:

• Manually select the Liquor Monitor installation folder from the left pane.

• Click the Jump To Default Liquor Monitor Directory button on the toolbar.

File version information for each executable appears in the left pane of the dialog 
box. 

3. (Optional) Click the Write Version Information To File button on the toolbar.  

a. From the resulting Save As dialog box, select a location and a name for this 
text file.

b. Click Save.

4. Click the Close and Save button.

TIP: Click the Jump To C: button on the toolbar to go to the root 
of your file system (usually Desktop). 

Changing Your Password
Occasionally, you should change your password for Liquor Monitor Manager. If you 
recently installed Liquor Monitor, be sure to get rid of any default passwords that come 
with the system as others will know them.
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To change your password:

1. From the Liquor Monitor SQL Utilities window, do one of the following:

• Select File Change Manager Password from the menu bar.

• Click the Change Manager Password button on the toolbar.

The Change Password dialog box opens.  

2. Type and verify your new password using the Enter New Password and Enter 
Password Again To Verify text boxes.

3. Click OK.

Managing Databases
Use Liquor Monitor Utilities to attach and detach databases, go live with a sample 
database, and count rows in non-empty tables.

Attaching a Database

You can add more databases for the database server to manage. For example, you may 
have a Liquor Monitor Scheduler database. For each database, you must have an MDF 
file.

To attach a database:

1. From the Liquor Monitor SQL Utilities window, select the database server, for 
example, Liquor Monitor-LT\Liquor Monitor.
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2. Do one of the following:

• Select File Attach Database from the menu bar.

• Select the Attach Database button on the toolbar.

The Attach Database dialog box opens.  

3. Fill the MDF File Of The Database To Attach text box by typing or browsing for 
the MDF file to be attached.

4. Use the name of the MDF file (automatically filled for you) or type a name for 
this database in the Attach Ad text box.

The name will appear in the Liquor Monitor SQL Utilities window.

5. Click OK.

Detaching a Database

You can detach a database from the database server only if there are currently no 
connections to it. Detaching a database converts the database to an MDF file that can be 
reattached later.

To detach a database:

1. From the Liquor Monitor SQL Utilities window, select the database, for 
example, Liquor Monitor-LT\Liquor 
Monitor\SampleData_FurnitureHomeFurnishings_Data.

2. Do one of the following:

• Select Commands Detach Database from the menu bar.

• Select the Detach Database button on the toolbar.
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The Detach Database dialog box opens.  

3. When there are no more connections or other problems, click Detach Database.

4. Confirm the detachment when prompted. 

Going Live

If you installed the sample data for Liquor Monitor when you installed Liquor Monitor, 
you were able to experiment with and evaluate the product. At some point in time, of 
course, you will want to use your own data. This transition is called “going live.”

To replace the sample data with your own database:

1. From the Liquor Monitor SQL Utilities window, select the database server. for 
example, Liquor Monitor-LT\Liquor Monitor.

2. Select the database that will replace your current Liquor Monitor database.

3. Do one of the following:

• Select Commands Go Live! from the menu bar.

• Select the Go Live! button on the toolbar.
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The Go Live dialog box opens.  

4. Select the check boxes for the data you want to use in the live database. The 
check boxes are:

• Customers

• Cashiers

• Registers

• Products

• Quick Service Menu

• Vendors

• Consignors

5. Click Go Live!

6. Click Yes to confirm when prompted.

7. Click Yes or No to backup the selected database before making it the Liquor 
Monitor database. (Yes is recommended.)

Liquor Monitor indicates progress with a progress bar and reports any errors. 
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Counting Rows In Database Tables

Liquor Monitor Utilities will count all the rows in non-empty tables for the selected 
database.

To count the rows in tables:

1. From the Liquor Monitor SQL Utilities window, select the database whose tables 
are to be counted.

2. Do one of the following:

• Select Commands Count Rows from the menu bar.

• Click the Display Row Counts For All Tables In Database button on the tool-
bar.

The Row Counts dialog box lists each table and the number of rows it contains.   

Managing Locations
Use Liquor Monitor Utilities to change location/store numbers and delete locations/
stores from the database.
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Changing Location Numbers

If you have more than one location, you usually set up one location first to make sure all 
the data is accurate and that Liquor Monitor is working correctly. Later you copy all the 
data to one or more other locations. Then you run this utility to change from the original 
location number to the correct location number for the current store.

To change a location:

1. From the Liquor Monitor SQL Utilities window, select the database to be altered.

2. Do one of the following:

• Select Commands Change Location from the menu bar.

• Click the Change Location button on the toolbar.

The Change Location Number dialog box opens. 

3. Type the location number in the Old Location Number text box or leave it blank 
to indicate all locations.

4. Type the new location number in the New Location Number text box.

5. Click OK.

Deleting Locations

Users rarely need to delete locations. If entries are mistakenly made and your database 
ends up with multiple location numbers, you will need to delete the unwanted location 
numbers.



Managing Tables 90

To delete a location:

1. From the Liquor Monitor SQL Utilities window, select the database to be altered.

2. Do one of the following:

• Select Commands Delete Location from the menu bar.

• Click the Delete Location button on the toolbar.

The Delete Location dialog box opens.   

3. Type the number of the location to be deleted in the Location Number To Delete 
text box.

4. Click OK.

Managing Tables
Liquor Monitor Utilities allows you to perform several operations on tables.

Viewing Table Structure

When you view a table’s structure, Liquor Monitor Utilities lists the fields that are 
normally thought of as the column headers for data in the database and displays the 
characteristics of that field. For example, you can review each field’s number, name, 
type, length, and determine whether this field is required. The fields (column headers) 
become the rows, and the column headers are number, name, and so on.
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To review a table’s structure:

1. From the Liquor Monitor SQL Utilities window, select a table.

2. Do one of the following:

• Select Commands View Table Structure from the menu bar.

• Click the View Table Structure button on the toolbar.    

Viewing Table Contents

Tables in relational databases contains rows and columns. The columns represent the 
fields in the table, and the rows represent records which contain values for those fields. 
For example, the Customer table would have a row for each customer and columns 
representing information about that customer. For example, the columns might be 
named CustNo, CustName, and so on.

When you view a table’s contents, Liquor Monitor Utilities displays rows and columns 
reflecting the data in the database.

To review a table’s contents:

1. From the Liquor Monitor SQL Utilities window, select a table.
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2. Do one of the following:

• Select Commands View Table Contents from the menu bar.

• Click the View Table Contents button on the toolbar.    

Sorting a Table

You can sort the data from tables based on one or more column headers while the data is 
displayed in the Liquor Monitor SQL Utilities window.

To sort the data:

1. From the right pane in the Liquor Monitor SQL Utilities window, drag the 
column header for the primary sort to the area just above the pane.

2. (Optional) Drag an additional column header to the area just above the plane to 
before a secondary, tertiary or additional sort.

3. Repeat step 2 as needed.
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The following figure shows the data in the Customer table sorted first by cus-
tomer last name and then by location.  

Printing a Table

You can print the contents of a table.

To print a table:

1. From the Liquor Monitor SQL Utilities window, select a table.

2. Do one of the following:

• Select Commands Print... from the menu bar.

• Click the Print button on the toolbar.

3. Use the resulting Print dialog box to set printer properties and so on.

4. Click Print.

The table’s contents are printed.

Displaying Table Rows

To save time, Liquor Monitor Utilities displays the first 200 rows of a table. You can 
request all of them if you need them.
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To display all the rows in a table:

1. From the Liquor Monitor SQL Utilities window, select a table.

2. Do one of the following:

• Select Commands Query for All from the menu bar.

• Click the Query Table for All Rows button on the toolbar.

All the table’s rows are displayed.

Getting Help for Stored Procedures

Liquor Monitor SQL Utilities provides some strings commonly used in stored 
procedures. You can copy these strings to use in stored procedures and same yourself 
some typing. You should use these strings only as advised by Liquor Monitor technical 
support. For example if you use the Liquor Monitor polling feature, a technical support 
representative might want to examine some records.

To display the strings:

1. From the Liquor Monitor SQL Utilities window, select a table.

2. Do one of the following:

• Select Commands SP Helper from the menu bar.

• Click the SP Helper button on the toolbar.

The Stored Procedure/SQL Helper Strings dialog box opens.
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Editing Values in Tables

Editing a value in a table manually is not a good idea. Nevertheless, there may be an 
occasion which you feel justifies the risk.

To edit a table:

1. From the Liquor Monitor SQL Utilities window, select a table.

2. Click the Database Is In Read-only Mode button on the toolbar.

3. Edit the values.

4. Click the Database Is In Read/Write Mode button on the toolbar.
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Clearing a Table

If you clear a table, you delete its contents. Its structure remains intact.

To empty the contents of a table:

1. From the Liquor Monitor SQL Utilities window, select a table.

2. Do one of the following:

• Select Commands Clear Table from the menu bar.

• Click the Clear Table button on the toolbar.

3. Click Yes to confirm the deletions when prompted.

The data disappears from the table.

Exporting Data

You can export the data from a table as a CSV file, a text file in which each line is a 
content row from the table with its values separated by commas. The first line of the file 
lists the names of the columns.

To export data from a table:

1. From the Liquor Monitor SQL Utilities window, select a table.

2. Do one of the following:

• Select Commands Export Data from the menu bar.

• Click the Export Data button on the toolbar.
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The Export Wizard appears.  

3. Click the browse button (...).

The Select CSV File to Save dialog box opens. 

4. Select a folder and provide a file name.

5. Click Save to return to the wizard.

6. Click Next.
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The Export Wizard dialog box for the Create/Load Data Map step opens.  

7. Do one of the following:

• Select the fields to be exported:

a. From the Fields In Table list box, select one or more field names to be export-
ed.

b. Click the right arrow to move these field names to the Fields To Export list 
box.

TIPS: Use the double-right arrow to move all the fields to the 
Fields To Export list box. 

Use the left-arrow to remove fields from the Fields To 
Export list box. 

Use the double-left arrow to empty the Fields To Export 
list box. 

Use the Up and Down buttons to order the fields in the 
exported file. Select a field and click Up and Down until it 
is located where you want it to be.
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Select Save Map to save this data map for later reuse. Give 
it a descriptive name when the Map Name dialog box 
appears.   

If the name you provide is not very useful, you can load the 
data map and rename the map using the Rename Map 
button.

• Use a data map that you have created in the past:

a. Select Load Map.     

b. From the resulting Load Map dialog box, select the name for the map from 
the Map Name list box.

c. Click OK to return to the Export Wizard.

TIPS: When you no longer need a map, load it using the Load 
Map button and then delete it using the Delete Map button.

8. From the Export Wizard, click Next.
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The Export Wizard dialog box for the Export Data step opens.  

9. (Optional) Type or paste a where clause to filter the rows in the table. For exam-
ple, you might want all customers with a given area code. Without a where 
clause, all the rows are exported.

10.Click Start.
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The Export Wizard dialog box shows progress and explains what is happening as 
it creates the CSV file.  

11.Click Close.

Importing Data
You can add data to a table by importing a CSV file. This file can be created by 
many applications, such as Microsoft Excel. 

It must be a text file with either commas or tabs separating the values in the file. 
Each line must represent a row in the table. If the first line contains the table’s 
column names, you do not need map the .CSV data to columns in the table. 
Tables have required fields, and every line of the .CSV file must contain a value 
for each of the required fields.

To import data to a table from a CSV file:

1. From the Liquor Monitor SQL Utilities window, select a table.

2. Do one of the following:

• Select Commands Import Data from the menu bar.
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• Click the Import Data button on the toolbar.

The Import Wizard appears.  

3. Click Next.

The Import Wizard dialog box for the file selection step opens.  

4. Identify the file to be imported.
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a. Click the browse button (...).

The Pick CSV File dialog box opens. 

b. Select a file name.

c. Click Open to return to the wizard.

d. Indicate the delimiter which separates values in the lines of the text file by se-
lecting Comma or Tab from the Delimiter Character drop-down list box.

e. Select or clear the First Line Of This CSV File Contains Column Names 
check box to indicate whether the column names are at the beginning of the 
file.

f. If the column names are in the file, you can select the Auto-Generate Import 
Rules Based On CSV Column Names check box.

g. Click Next.

The Import Wizard dialog box for the Create/Load a Map step opens. It displays 
the table structure for the selected table.   

5. If you are not auto-generating rules, you must load a data map.
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a. Select Load Map.     

b. From the resulting Load Map dialog box, select the name for the map from 
the Map Name list box.

c. Click OK to return to the Export Wizard.

TIPS: Select Save Map to save auto-generated rules as a data 
map.

Select Rename Map to save the currently loaded data map 
for later reuse. Give it a descriptive name when the Map 
Name dialog box appears.     

When you no longer need a map, delete it using the Delete 
Map button.

6. Click Next.
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The Import Wizard dialog box for the Import step opens.

7. Click Start.

The Import Wizard dialog box shows progress and explains what is happening as 
it fills the table using data from the CSV file.  

8. Click Close.
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Setting and Clearing Modified Flags
Modified flags are what tell polling systems if the row of data has been modified since 
the last replication. Sometimes you need to set or clear these flags to correct polling or 
synchronization problems. Usually you would do this only with the advice and 
assistance of Liquor Monitor technical support.

Setting Flags

You can set flags for the entire database, one or more tables within that database, or the 
selected table.

To set flags for more than one table:

1. From the Liquor Monitor SQL Utilities window, select a database.

2. Do one of the following:

• Select Commands Set Modified Flags For One Or More Tables from the 
menu bar.

• Click the Set Modified Flags For One Or More Tables button on the toolbar.

The Set Modified Flag Tables Wizard dialog box opens.   
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3. Select the tables whose flags are to be set:

a. From the Tables In Database list box, select one or more table names.

b. Click the right arrow to move these table names to the Tables To Modify list 
box.

TIPS: Use the double-right arrow to move all the tables in the 
database to the Tables To Modify list box. 
Use the left-arrow to remove tables from the Tables To 
Modify list box. 
Use the double-left arrow to empty the Tables To Modify 
list box. 

4. Click Modify Tables.

A confirmation box appears.  

5. Do one of the following:

• Clear the Modify Only For The Following Location text box to modify the 
rows of the table for all locations (stores).

• Type a location number in that text box to modify the rows of the table just 
one location.

6. Click Yes to set flags in the selected tables.

A progress box shows the progress from table to table.  
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The Process Complete dialog box lets you know that the flags have all been set.    

To set flags for a table:

1. From the Liquor Monitor SQL Utilities window, select a table.

2. Do one of the following:

• Select Commands Set Modified Flags from the menu bar.

• Click the Set Modified Flags button on the toolbar.

A confirmation box appears.  

3. Do one of the following:

• Clear the Modify Only For The Following Location text box to modify the 
rows of the table for all locations (stores).

• Type a location number in that text box to modify the rows of the table just 
one location.

4. Click Yes to set flags in the selected table.

Clearing Flags

You can clear flags for the entire database, one or more tables within that database, or 
the selected table.
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To clear flags for more than one table:

1. From the Liquor Monitor SQL Utilities window, select a database.

2. Do one of the following:

• Select Commands Clear Modified Flags For One Or More Tables from the 
menu bar.

• Click the Clear Modified Flags For One Or More Tables button on the tool-
bar.

The dialog box opens.  

3. Select the tables whose flags are to be set:

a. From the Tables In Database list box, select one or more table names.

b. Click the right arrow to move these table names to the Tables To Modify list 
box.

TIPS: Use the double-right arrow to move all the tables in the 
database to the Tables To Modify list box. 
Use the left-arrow to remove tables from the Tables To 
Modify list box. 
Use the double-left arrow to empty the Tables To Modify 
list box. 

4. Click Modify Tables.
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A confirmation dialog box appears.  

5. Do one of the following:

• Clear the Modify Only For The Following Location text box to modify the 
rows of the table for all locations (stores).

• Type a location number in that text box to modify the rows of the table just 
one location.

6. Click Yes to clear flags in the selected tables.

A progress box shows the progress from table to table. 

The Process Complete dialog box lets you know that the flags have all been 
cleared.

To clear flags for a table:

1. From the Liquor Monitor SQL Utilities window, select a table.

2. Do one of the following:

• Select Commands Set Modified Flags from the menu bar.

• Click the Clear Modified Flags button on the toolbar.

A confirmation box appears.  

3. Do one of the following:

• Clear the Modify Only For The Following Location text box to modify the 
rows of the table for all locations (stores).
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• Type a location number in that text box to modify the rows of the table just 
one location.

4. Click Yes to clear flags in the selected table.

The SQL Query Interface dialog box opens.   

5. Type the query in the upper pane.

6. Click the Execute SQL button on the toolbar.    

The results of the query appear in the lower pane.

 TIPS: You can sort the data matching the query by dragging 
column headers to the gray area between the two panes.
Click the Print button on the toolbar to print the results.  

Backing Up Your Database
If you are not using automatic backup, you should back up your database manually on a 
regular basis. Some Liquor Monitor users do nightly backups; others do weekly 
backups. The Backup Manager utility can display both automatic and manual backups, 
but they are in separate views.
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Reviewing Backups

If you want to review a backup (for example, so that you can delete it or restore from it), 
you need to know if it was automatic or manual. Perhaps you will review both manual 
and automatic backups looking for the most recent.

To review backups:

1. From the Liquor Monitor SQL Utilities window, do one of the following:

• Select Commands Backup Manager from the menu bar.

• Click the Backup Manager button on the toolbar.

The Manual Backups For Liquor Monitor window opens.    

2. (Optional) To review automatic backups, click the Automatic Backups button on 
the toolbar.   

Creating a Manual Backup

Some Liquor Monitor users do nightly backups; others do weekly backups, depending 
on how much data accumulates daily and so on.

To back up your database manual:

1. From the Liquor Monitor SQL Utilities window, select the database, for 
example, Liquor Monitor-LT\Liquor Monitor\Liquor Monitor.

2. Do one of the following:

• Select Commands Backup Manager from the menu bar.

• Click the Backup Manager button on the toolbar.



Backing Up Your Database 113

The Manual Backups For Liquor Monitor window opens. 

3. Click the Save New Backup button on the toolbar.

The Select Directory dialog box opens. 

4. Select a location for the backup file to be stored. The default is the Liquor Moni-
tor installation directory and is recommended.

5. Click OK.

The selected database is backed up and you are informed about the operation’s 
success or errors that occurred. The new backup is added to the information in 
the Manual Backups For Liquor Monitor window.

Overwriting a Backup

If you are running out of storage space, you might want to create a new backup by 
overwriting an older one.

To overwrite an existing backup:

1. From the Manual Backups For Liquor Monitor window, select the backup to be 
overwritten.

2. Click the Overwrite Existing Backup button on the toolbar.

The selected backup is overwritten by a new backup of the same database. The 
date, time, and size are updated. Be careful as you are not asked to confirm. 

You are informed about the operation’s success or errors that occurred. 
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Deleting Old Backups

You can keep backups forever, but you may decide that a backup that is over a month, 
six months, or a year old is no longer needed.

To delete a backup:

1. Open either the Manual Backups or the Automatic Backups window.

2. Select the backup to be deleted.sp 

3. Click the Delete button on the toolbar.   

4. Click Yes to confirm the deletion when prompted.

The selected backup is deleted and you are informed about the operation’s suc-
cess or errors that occurred. 

Registering a Backup from Another Server

You can add a backup from another server to the list of backups. That backup should be 
for the same version of the database.

To register a backup:

1. From the Manual Backups For Liquor Monitor window, click the Register 
Backup From Different Server button on the toolbar.   

The Select Target File dialog box opens.

2. Locate the .bak file to be registered and click Open.

The selected backup is registered unless errors occurred. 
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Restoring a Backed Up Database

You can restore a backed up database. For example, if your database has become 
corrupted, you might be forced to return to an earlier version.

To restore a database you have backed up:

1. From the Manual Backups or Automatic Backups window, select the backup to 
be restored.

2. Click the Restore from Selected Backup button on the toolbar.   

3. Click Yes to confirm when prompted.

The selected backup is restored and you are informed about the operation’s suc-
cess or errors that occurred. This does not removed the selected backup from the 
Manual Backups or Automatic Backups window. You can restore from it again if 
you need to.

The Backup window opens. 

4. Identify the database to be restored by selecting it from the Backup Or Restore 
drop-down list box.

5. In the To A Backup File At This Location text box, select the location to store 
the backup and the name of the backup file by typing or browsing for its path.



Appendix A
Installing Liquor Monitor

You can use Liquor Monitor whether or not you use a point-of-sale product.

System Requirements

Before you install Liquor Monitor, make sure that your system has the correct requirements. 

The following requirements are minimum.

• An IBM compatible computer (300 MHz CPU or higher)
• Microsoft Windows 2003 Server, 2000 Server, Vista Professional, XP 

Professional, 2000 Professional

Always use the latest Service Pack and patches for your operating system.

• 40 GB Hard Disk Drive space
• 512MB RAM
• Access to the Microsoft SQL Server 2000, 2005 or 2008 database (installed as 

part of Liquor Monitor if not already available)

Installing Liquor Monitor

If your computer does not already have an appropriate Microsoft SQL Server or Microsoft 
SQL Server Desktop Engine (MSDE) database, MDSE is added as part of the Liquor Monitor 
installation.

To install Liquor Monitor:

1. Double-click setup.exe either on the CD or as the result of a download.

In general you follow the directions that appear on the screen.
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First you see a couple of preparing to install dialog boxes.   

2. From the Welcome dialog box, click Next.   

3. The Customer Information dialog box will display your user name and company (if 
already stored on the computer). 

a. Otherwise, type in a user name and organization.



Installing Liquor Monitor 118

b. Select the “Anyone....” or “Only for me...” option button to indicate who should be 
able to use Liquor Monitor from this computer.

c. Click Next.

4. From the Ready to Install dialog box, click Install. 

If you do not have an appropriate Microsoft SQL Server or MSDE database, a few 
dialog boxes indicate that MSDE is being installed.

An Installing dialog box also appears.  
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5. When the installation is completed, click Finish. 

Payment Card Industry Compliance

The Payment Card Industry (PCI) provides a list of requirements and security assessment 
procedures. You must comply with all of them or be liable to a penalty. Along with Liquor 
Monitor, you received a copy of the Data Security Standard, version 1.2, dated October 2008.

The PCI document provides much more data than is covered here. Please read it. However, 
below the 12 requirements are categorized and listed as in that document along with 
information about how Liquor Monitor meets requirements 3 and 4 for you and assists you 
with requirement 8. You must take measures to secure compliance with all 12 requirements. 
Documenting how you achieve that compliance is a good idea. That documentation can be 
presented if you are ever investigated.

Build and Maintain a Secure Network

1. Install and maintain a firewall configuration to protect cardholder data

2. Do not use vendor-supplied defaults for system passwords and other security 
parameters

Protect Cardholder Data

3. Protect stored cardholder data.

4. Encrypt transmission of cardholder data across open, public networks.

Maintain a Vulnerability Management Program 

5. Use and regularly update anti-virus software.

6. Develop and maintain secure systems and applications.
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Implement Strong Access Control Measures

7. Restrict access to cardholder data by business need-to-know.

8. Assign a unique ID to each person with computer access.

9. Restrict physical access to cardholder data.

Regularly Monitor and Test Networks

10. Track and monitor all access to network resources and cardholder data.

11. Regularly test security systems and processes.

Maintain an Information Security Policy

12. Maintain a policy that addresses information security.

How Liquor Monitor Facilitates These Requirements

Liquor Monitor performs requirements 3 and 4 for you. It encrypts both stored cardholder data 
and transmissions of that data across open, public networks. 

Liquor Monitor facilitates with requirement 8. Using Liquor Monitor’s setup options for 
employees, you can assign a unique ID to each person with computer access. However, there 
are several other requirements that Liquor Monitor has no control over. To ensure the safety of 
customer credit data, please take measures to comply with all the requirements.

Customer Service

Make sure you maintain a current Service and Maintenance Plan with Liquor Monitor, LLC. 
so that you receive upgrades and support on Liquor Monitor. For more information, please call 
1-866-202-7532.



Appendix B
Complying with FCC Rules

For U.S. FCC (Federal Communications Commission) certification, Liquor Monitor spouts 
should have a permanently attached label in a conspicuous location with the following statement:
 
FCC ID: YENNOP0611
This device complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions:
 (1) This device may not cause harmful interference and
 (2) this device must accept any interference received, 
      inculding interference that may cause undesired operation.
 
 
The Liquor Monitor spout has been tested and found to comply with the limits for a class B 
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. A spout 
generates, uses and can radiate radio frequency energy and if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular installation. 

If a spout causes harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, you are encouraged to try to correct the 
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna
• Increase the separation between the spout and receiver
• Connect the equipment and receiver to outlets that are on different circuits
• Consult the dealer for help.

                    
                    
                   The user is cautioned that changes and modifications made to the equipment without the approval 
                    of manufacturer could void the user's authority to operate this equipment.  
 
 
                                       Notice To The User For RF Exposure FCC Certification
                 Caution:
                  Exposure to Radio Frequency Radiation. The device shall be used in such a manner that the 
                  potential for human contact during normal operation is minimized. This equipment complies with 
                  FCC radiation exposure limits set forth for an uncontrolled environment. This equipment should be
                  installed and operated with a minimum distance of 20cm between the radiator and your body. 
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